
Level 2



Funded by the European Union. Views and opinions expressed are however those of
the author(s) only and do not necessarily reflect those of the European Union or the
European Education and Culture Executive Agency (EACEA). Neither the European
Union nor EACEA can be held responsible for them.

WA07 ICT Skills: 19 Basic ICT Skills

Use presentation software to produce routine and non-routine 
presentations

LO2.24 Demonstrate the ability to use presentation software tools and techniques safely and securely to
produce routine and non-routine electronic presentations that meet the requirements of the office.

Unit Details
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Presentations

Presentations can be produced on paper, but 
can also be produced electronically.
Presentations can be produced using various 
software, such as Microsoft PowerPoint.



Microsoft PowerPoint

Microsoft PowerPoint is a software product used to perform 
computer-based presentations. 

Presentations are mainly used for showing and explaining a topic in 
front of an audience.

There are various circumstances in which a presentation is used: 
Teaching a class, introducing a new product, explaining an 
organizational structure, etc.



Microsoft PowerPoint

• PowerPoint is a visual and graphical application.
• With PowerPoint, you can create, view, and present slide shows that combine 

text, shapes, pictures, graphs, animation, charts, videos, and much more.
• You will recognize some of the features of the PowerPoint window that are 

common to most Windows programs, such as the Tabs with the Groups. 
• Although, some toolbar buttons and panes are new and specific to PowerPoint. 



• Create, open, and name a 
presentation

• Go to powerpoint.office.com.

• Or sign in to office.com/signin, 
select the Office 365 App Launcher 
The app launcher icon in Office 
365, and then select PowerPoint.

• Select New blank presentation, 
open a Recent file, or select one of 
the themes.

Microsoft PowerPoint
Start



A quick walkthrough of the PowerPoint interface

• 1. File: 
– Choose this button to open a new 

presentation, save the presentation, 
and access PowerPoint options.

• 2. Quick Access 
Toolbar: 

– This is a customizable toolbar 
placed by default next to the Office 
Button -- you can add icons for 
your often used commands to this 
toolbar.

• 3. Ribbon: 
– The Ribbon has tabs, which in turn 

contain groups of buttons for 
various options - some groups also 
contain galleries (for example, 
galleries for Themes and Theme 
Colors).



A quick walkthrough of the PowerPoint interface

• 4. Slides/Outline Pane: 
– Normally placed on the left side of the 

interface, this pane contains two tabs, 
the Slides tab and the Outline tab. The 
Slides tab shows thumbnails of all the 
slides in the open presentation. The 
Outline tab shows the same slides in 
outline view.

• 5. Status Bar: 
– A horizontal strip that provides 

information about the open presentation 
like slide number, applied theme, etc. It 
also includes the view and zoom 
options.



A quick walkthrough of the PowerPoint 
interface

• 6. Notes Pane: 
– Directly below the active slide, this is where you input your speaker notes for the current slide. None of this 

content is visible on the actual slide while presenting - although it is visible in both Notes Page view and 
Presenter view.

• 7. View Buttons: 
– There are three view buttons, as well as a zoom-in and zoom-out bar, displayed on the status bar located on 

the lower right hand corner of the window.
– Normal View - Clicking this enables Normal view; Shift-clicking this gets you to Slide Master view.

– Slide Sorter View - Clicking this displays zoomable thumbnails of every slide in the open presentation. 
Shift-clicking this button gets you to Handout Master view.

– Slide Show from current slide - Show the presentation as a full screen slideshow from the current 
selected slide. Shift-clicking brings up the Set Up Show dialog box. 



A quick walkthrough of the PowerPoint interface

• 8. Slide Area: 
– Displays the active slide. 

• 9. Task Pane: 
– The Task Pane contains more 

options and appears when you 
choose an option in one of the 
Ribbon tabs, for example if you click 
the Clip Art button on the Insert tab 
of the Ribbon, the Clip Art task 
pane opens (as shown in the figure 
above on this page). 

• 10. Mini Toolbar: 
– This toolbar is not shown in the 

figure located here; it is a semi-
transparent floating toolbar that 
spawns right next to the cursor, and 
it is also available instantly with a 
right-click.



PowerPoint: How to add a new slide

In the Home tab of the 
Ribbon, click the New Slide 
button, as shown in the 
Figure. 



PowerPoint: How to delete a slide

• Open the Sides tab:
You will see a list of your slides in thumbnails

• Select the slide to delete:
Click on the thumbnail

• Right-Click and choose 
Delete:
The slide is deleted



PowerPoint: How to move between slides

• Whilst creating your PowerPoint 2007 presentation, 

you may need to move back and forth through your 

PowerPoint slides. The most common way to move 

around in a PowerPoint presentation is to press the 

Page Down and Page Up keys:

• Page Down moves you forward to the next slide in 

your presentation.

• Page Up moves you backward to the preceding 

slide in your presentation.



Saving, closing and opening a presentation

• When you create a presentation, and then save it as a PowerPoint file, you can 
share it with your colleagues and reuse it more than once. 

• Click the Microsoft Office Button, and then click Save as.
• In the File name box, type a file name, or do nothing to accept the suggested file 

name.
• In the Save as type list, click PowerPoint Template, and then click Save.



Saving a presentation in the cloud

• You can save a PowerPoint 2013 or PowerPoint 2016 presentation to 
Microsoft OneDrive to make it easier to access, store, and share your 
files in the cloud.

• To know how to do it, go to this link:

https://support.office.com/en-gb/article/Save-and-share-a-presentation-
to-OneDrive-cdbec569-a18f-4bdc-92e8-d07a8ab5eb95 

https://support.office.com/en-gb/article/Save-and-share-a-presentation-to-OneDrive-cdbec569-a18f-4bdc-92e8-d07a8ab5eb95
https://support.office.com/en-gb/article/Save-and-share-a-presentation-to-OneDrive-cdbec569-a18f-4bdc-92e8-d07a8ab5eb95


The difference between Save and Save as

- Save will save your current state.

- Save as will allow you to change parameters.

- Therefore, if you had if you had a text document or a picture open, 
save would save it in its current state (same format, appearance and 
so on), but save as would allow you to change its name or, in the 
case of a picture, it would allow you to transfer it into another file 
type (ABC instead of abc, for example). 



Saving, closing and opening a presentation

• Opening a presentation:
– To open a presentation, take the standard route - click the Office button and 

choose Open.

• Closing a presentation:
– To close a presentation, save your file and use one of these techniques:

– Click the Office button and choose Close on the drop-down list. The PowerPoint 
program remains open, although the presentation is closed.

– Click the Close button marked with an X in the upper-right corner of the 
Powerpoint window. Clicking the X button closes Word as well as your 
document.



Creating a simple presentation

• Start with a template or theme. 
– A template or theme will dress up your 

presentation with pre-made layouts and color 
schemes. Choose one by clicking the Office orb 
in the upper-left corner, and selecting New. 
Then, on the left, select Installed Templates or 

Installed Themes. 



Professional Graphic Design

Branding

Speed

Quick Customization

Consistency

Advantages of templates



Creating a simple presentation

• Browse through the slides from the template and see what you like:
– On the sidebar on the left, you can click on different template or theme slides to see what they look 

like.

– Change the layout of your slides. You can select slides that have more or less text boxes, photo 
boxes, or any other template items you want. Select a slide, right click, and hover over Layout.

− Add slides. If you want your new slide to look exactly like the one before it, right click that slide 
and select New. Or, if you want a new slide with a completely different layout, click Home, then 
the drop menu under New Slide.

− Organize your slides. You can drag and drop slides in the sidebar to the left to reorder them.



The views of PowerPoint

PowerPoint has several views. 

Depending on the task at hand, 

some PowerPoint views are better 

than others when designing and 

editing PowerPoint slides and 

presentations. PowerPoint offers 

two places to change the view: the 

View buttons on the Status bar and 

The Ribbons on the View tab.



Working in the Outline View 

• You can add a new slide in the 
Outline View the same way 
that you do in Slide View: 

1.  On the Common Tasks toolbar, click New 

Slide. 

2.   In the New Slide dialog box, click a slide 
layout, then click OK. A new slide icon 
appears in your outline.  



Selecting and Formatting text

• Change Font Typeface and 
Size

To change the font typeface:

– Click the arrow next to the font name and 
choose a font. 

– Remember that you can preview how the 
new font will look by highlighting the text, 
and hovering over the new font typeface.



Selecting and Formatting text

• To change the font size:
– Click the arrow next to the font size and 

choose the appropriate size, or

– Click the increase or decrease font size 
buttons.



Selecting and Formatting text

• Font Styles and Effects
• Font styles are predefined 

formatting options that are 
used to emphasize text. 

• They include: Bold, Italic, 
and Underline. 

• To add these to text:
– Select the text and click the Font Styles 

included on the Font group of the Home 
tab or

– Select the text and right click to display 
the font tools



Inserting a picture



To undo an action, do one or more 
of the following:
Click Undo on the Quick Access 
Toolbar. 
To redo an action that you undid, 
click Redo on the Quick Access 
Toolbar.

The commands Undo and Redo



Methodological Tool I
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Creating and printing a 
professional presentation!
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Data processing and formatting

Insert a header and footer

• Go to “Insert” then 
“Header and Footer”.

• This dialog box allows 
you to add a date and 
time on the slide.



Data processing and formatting

Insert pictures from files

• Go to the “Insert” ribbon 

then select “Picture”

• Locate the image file 

from the folder to where 

it is saved

• Select “Insert” from the 

dialog box



Data processing and formatting

Insert Clip Art

• Go to the “Insert” ribbon 

then select “Clip Art”

• Enter search terms in 

Clip Art search pane on 

the right and select image



Data processing and formatting

Format Pictures

• To resize the image, 

click on the picture to 

surround the image with 

a blue box

• Drag the corner dot 

away from the center to 

make it larger and 

toward the center to 

make it smaller



Data processing and formatting

Using WordArt

• Go to the “Insert” ribbon 

and then select 

“WordArt”

• Click on the design you 

would like and it should 

automatically take you to 

the Drawing Tools 

Format tab



Data processing and formatting

In the Edit WordArt text  dialog box, type 

your text and select the desired font and 

size

You can select different shape styles,  insert shapes, and 

arrange your text

To the right and at the bottom of WordArt Styles area you 

can change your text by adding an effect



Data processing and formatting

Insert Charts

Go to the “Insert” ribbon then 
select the “Chart” button

Option to choose from Area, Bar, 
Line, Pie and several other chart 
options



Data processing and formatting

• Go to the “Insert” ribbon then 
select the “SmartArt” button

• Option to choose from List, 
Process, Cycle, Hierarchy and 
several other options



Perform spelling and grammar check

Go to the “Review” ribbon then hover over 
“Proofing” and select “Spelling”

PowerPoint finds possible spelling and grammar 
mistakes and makes suggestions to correct them

Data processing and formatting



Non-routine presentation

Design
• Go to the “Design” ribbon to scroll through different 

backgrounds and styles

1. Click on themes 
and go to the color 
tab to change the 
color of the theme

2. You can also 
change the font and 

add some fun 
effects

3. Allows you to 
change Background 

Styles and hide 
Background 

Graphics



• To access the  different 

slide views, click on the 

“View” ribbon at the top of 

the screen

• On the left end of the view 

ribbon you will see the 

different choices to view 

your slide

Non-routine presentation

Different ways to View PowerPoint



Non-routine presentation

Print handouts

• Select “File” then 

select “Print”

– A dialog box appears 

that allows you to 

change the printer and 

select the number of 

copies to be printed

• You can also select to 

print handouts of the 

slideshow



Methodological Tool II
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• Presentations can be produced on paper, but can also be produced 

electronically.

• Presentations can be produced using various software, such as 

Microsoft PowerPoint.

• Save will save your current state.

• Save as will allow you to change parameters.

• To undo an action, do one or more of the following:

• Click Undo on the Quick Access Toolbar. 

• To redo an action that you undid, click Redo on the Quick Access 

Toolbar.

Module Key Points



Module Key Points

• Slides include different kinds of content: Text, images, 

hyperlinks, SmartArt and more

• Change the design of a presentation by using and editing a 

theme.

• Inserting:

SmartArt

WordArt

Pictures

ClipArt

• You can make your presentation more interesting by adding 

effects. Effects include Transitions and Animations.



Revision Questions 

Revision Question 1

What are the necessary functions of 

PP for the creation non routine 

documents?

Revision Question 2

How can we check spelling and 

grammar?

Revision Question 3

How can we insert:

SmartArt

Animations

Transitions

WordArt



WELL DONE
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You have completed Unit 2.13
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